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Experiment H�-1: Auditory 
and Visual Reflexes

Background

During our day-to-day lives we detect changes in the 

environment and react appropriately. An external 

stimulus is detected by one or more neurons, which 

sends the sensory information to the central nervous 

system, where it is processed. If a motor response is 

initiated, it usually involves a series of action potentials 

which produce a muscle contraction and a movement of 

one or more parts of the body. A simple reflex is perhaps 

the easiest of this type of stimulus-response reaction. A 

loud sound or something flying at your eye makes you 

blink, while a tap on the tendon under the knee cap 

produces the knee-jerk (or myotactic) reflex.

 Figure H	-1-1: A cross section of the spinal cord showing the single synapse 

between the sensory and the motor neurons involved in the myotactic reflex.

A simple reflex like the myotactic reflex is produced via 

single synapses between sensory axons and motor 

neurons. The required circuitry for this reflex is confined 

to the spinal cord, as shown in Figure HN-1-1 on page 

HN-1-1. Sensory information also ascends to higher 

centers, but the brain is not necessary or required to 

perform the reflex. More complex reflexes usually 

involve additional (inter-) neurons and more than one 

population of motor neurons. Thus, more neurons and 

synapses are involved, which usually results in a longer 

delay between stimulus and response and often a more 

complex response. One example of such a complex 

response is the flexion withdrawal reflex, where a 

noxious stimulus to one leg causes withdrawal of the 

stimulated leg and extension of the other.

In this lab you will study the time taken between a 

stimulus and the response. These reaction time 

measurements will be made from an individual subjected 

to harmless visual and sound stimuli. In addition, the 

effect of priming and prediction will be examined.

Equipment Required

PC Computer

IWX/214 data acquisition unit

USB cable

IWX/214 power supply

EM-100 Event marker

IWX/214 Setup

1 Place the IWX/214 on the bench, close to the computer.

2 Check Figure T-1-1 in the Tutorial Chapter for the location of 

the USB port and the power socket on the IWX/214.

3 Check Figure T-1-2 in the Tutorial Chapter for a picture of 

the IWX/214 power supply.

4 Use the USB cable to connect the computer to the USB port 

on the rear panel of the IWX/214. 

5 Plug the power supply for the IWX/214 into the electrical 

outlet. Insert the plug on the end of the power supply cable 

into the labeled socket on the rear of the IWX/214. Use the 

power switch to turn on the unit. Confirm that the red power 

light is on.

Start the Software

1 Click on the LabScribe shortcut on the computer’s desktop 

to open the program. If a shortcut is not available, click on 

the Windows Start menu, move the cursor to All Programs 

and then to the listing for iWorx. Select LabScribe from the 

iWorx submenu. The LabScribe Main window will appear 

as the program opens.

1 On the Main window, pull down the Settings menu and 

select Load Group.

2 Locate the folder that contains the settings group, 

IPLMv4.iwxgrp. Select this group and click Open.

3 Pull down the Settings menu again. Select the Auditory-

VisualReflexes-LS2 settings file.

4 After a short time, LabScribe will appear on the computer 

screen as configured by the Auditory-VisualReflexes-LS2 

settings.

5 For your information, the settings used to configure the 

LabScribe software and the IWX/214 unit for this exper-

iment are listed in Table HN-1-1 on page HN-1-2. These 

settings are programmed on the Preferences Dialog 

window which can be viewed by selecting Preferences 

from the Edit menu on the LabScribe Main window.
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Event Marker Setup

1 Locate the EM-100 event marker (Figure HN-1-2 on page 

HN-1-2), in the iWorx kit.

2 Plug the DIN8 connector to the EM-100 event marker into 

the Channel 3 input of the IWX/214 (Figure HN-1-3 on page 

HN-1-2).

 Figure H	-1-2: The EM-100 event marker.

Exercise 1: Reaction Time and Visual Cues

Aim: To measure the reaction time of a subject to a 

visual cue.

Procedure

1 Instruct the subject to:

• Sit in a chair and face the computer screen.

• Position a hand on the keyboard in a manner that enables 
the subject to push the F1 key as quickly as possible.

• Watch the right side of the computer screen and quickly 
press the F1 key on the keyboard when the signal generated 
by the event marker first appears.

2 Out of sight of the subject, another student should prepare 

to quietly press and release the button of the event marker. 

In this exercise, the subject will perform ten trials.

 Figure H	-1-3: The EM-100 event marker connected to an IWX/214.

Warning: In this exercise, it is important to press and 

release the button of the event marker quietly because any 

sound could be used by the subject as a cue.

3 Type <Subject’s Name> Visual Cues in the Mark box that 

is to the right of the Mark button. Press the Enter key to 

mark the recording.

4 Click on the Record button. Instruct the subject to press the 

F1 key on the keyboard to mark the recording as soon as 

he or she sees the visual cue on the right side of the 

computer screen (Figure HN-1-4 on page HN-1-2).

 Figure H	-1-4: Three visual cues, each followed by the subject’s response, 

are displayed on the Main window. Each visual cue is made by pushing the 

button of the EM-100 event marker momentarily; each response mark is made 

by the subject pushing the F1 key on the keyboard.

5 Instruct the subject that the exercise has begun and that a 

visual cue could appear on the screen at any time

6 Use the event marker to deliver ten visual cues to the 

subject. The cues should not be less than five seconds nor 

more than ten seconds apart. 

Table HN-1-1: Sett ings on the Channel Window 

of the Preferences Dialog Used to Configure the 

iWorx Recording System for Experiment HN-1.

Parameter Units /Ti t le Sett ing
Mode/

Funct ion

Acquis i t ion Mode Chart

Star t User

Stop User

Disp lay Time Sec 5

Speed Samples/Sec 200

Channel A3 React ion Time S DIN8
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7 After the tenth cue, click Stop to halt recording.

8 Select Save As in the File menu, type a name for the file. 

Choose a destination on the computer in which to save the 

file, like your lab group folder). Designate the file type as 

*.iwxdata. Click on the Save button to save the data file. 

Data Analysis

1 Scroll to the beginning of the data recorded for Exercise 1 to 

display the first trial on the Main window.

2 Use the Display Time icons to adjust the Display Time of 

the Main window to show both the visual cue made with 

the event marker and the mark made by the subject’s 

response on the Main window. This trial can also be 

selected by:

• Placing one cursor before the beginning of the visual cue 
and the second cursor after the mark made by the subject; and

• Clicking the Zoom between Cursors button on the 
LabScribe toolbar to expand the complete reaction trial to the 
width of the Main window.

 Figure H	-1-5: The LabScribe toolbar.

3 Click on the Analysis window icon in the toolbar (Figure 

HN-1-5 on page HN-1-3) or select Analysis from the 

Windows menu to transfer the data displayed in the Main 

window to the Analysis window (Figure HN-1-6 on page 

HN-1-3).

4 Look at the Function Table that is above the display of the 

Reaction Time channel displayed in the Analysis window. 

The mathematical function, T2-T1, should appear in this 

table. The value for T2-T1 is seen in the table across the top 

margin of the Reaction Time channel.

5 Use the mouse to click on and drag a cursor to the onset of 

the signal used as the visual cue. Drag the other cursor over 

the mark made by the subject responding to the visual cue.

6 Once the cursors are placed in the correct positions for 

determining the reaction time, record the value for T2-T1 in 

the Journal. The value can be recorded in the on-line 

notebook of LabScribe by typing its name and value directly 

into the Journal. You may also record any data on separate 

data tables.

7 The functions in the channel pull-down menus of the 

Analysis window can also be used to enter the name and 

value for T2-T1 into the Journal. To use these functions:

• Place the cursors at the locations used to measure the 
reaction time.

• Transfer the name of the T2-T1 function to the Journal using 
the Add Title to Journal function in the Reaction Time 
Channel pull-down menu.

• Transfer the value for T2-T1 to the Journal using the Add 
Ch. Data to Journal function in the Reaction Time Channel 
pull-down menu.

8 Once the reaction time in the first trial is measured and 

recorded, use the scroll bar at the bottom of the Analysis 

window to move the data from the second trial onto the 

window. If needed, use the Display Time icons to adjust the 

width of the Analysis window to show both the visual cue 

and the subject’s response on the same window.

9 Repeat Steps 5 through 7 on the data from the second trial.

10 Use the same techniques used in Steps 5 through 8 to 

measure the reaction times from the other eight trials.

11 Once the reaction times in all ten trials have been measured 

and recorded, open the Journal and use the values to 

determine the mean reaction time of the subject. Discard 

the longest and shortest times from the data set, and 

determine the average of the eight remaining reaction 

times. Record the mean reaction time for this exercise in 

Table HN-1-2 on page HN-1-4.

 Figure H	-1-6: A visual cue, followed by the subject’s response, are 

displayed on the Analysis window. The two cursors are positioned at the 

beginning of the visual cue and on the mark for measurement of the subject’s 

reaction time (T2-T1) in this trial.

Exercise 2: Reaction Time and Auditory Cues

Aim: To measure the reaction time of a subject to an 

auditory cue.

Procedure

1 Cover the computer screen with an opaque piece of 

construction paper to prevent the subject from seeing any 

signal on the screen as a visual cue.

2 Instruct the subject to:

• Sit in a chair in front of the computer keyboard.

• Position a hand on the keyboard in a manner that enables 
the subject to push the F1 key as quickly as possible.

• Listen for the click (sound) of the event marker as the other 
student presses the button and then press the F1 key as 
quickly as possible.
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3 Out of sight of the subject, another student should prepare 

to sharply tap the button of the event marker to create a 

auditory cue that is also recorded as a signal on the 

Reaction Time channel. In this exercise, the subject will 

perform ten trials.

4 Type Auditory Cues in the Mark box that is to the right of 

the Mark button. 

5 Click on the Record button. Instruct the subject to press the 

Enter key on the keyboard to mark the recording.

6 Instruct the subject that the exercise has begun and that a 

auditory cue could be heard at any time

7 Use the event marker to deliver ten auditory cues to the 

subject. The cues should not be less than five seconds nor 

more than ten seconds apart. 

8 After the tenth cue, click Stop to halt recording.

9 Select Save in the File menu. 

Data Analysis

1 Use the same technique explained in Exercise 1 to measure 

and record the reaction times of the subject presented with 

auditory cues.

2 Enter the mean reaction time for this exercise in Table HN-

1-2 on page HN-1-4.

Question

1 How does the subject’s mean reaction time to visual cues 

compare to his or her mean reaction time to auditory cues?

2 What would cause a longer reaction time to one type of cue 

as compared to another?

3 How do your subject’s mean reaction times compare to 

those of other subjects?

4 Do all subjects respond more quickly to the same cue?

Exercise 3: Reaction Time and Prompted 
Auditory Cues

Aim: To measure the reaction time of a subject to an 

auditory cue delivered immediately after a verbal 

prompt.

Procedure

Repeat Exercise 2 with an additional step. Before each 

auditory cue is delivered, tell the subject to get ready to 

respond to the cue. It is best to use a one word cue 

before immediately clicking the event marker button.

Data Analysis

1 Use the same technique explained in Exercise 1 to measure 

and record the reaction times of the subject presented with 

prompted auditory cues.

2 Enter the mean reaction time for this exercise in Table HN-

1-2 on page HN-1-4.

Exercise 4: Reaction Time and Predictable 
Auditory Cues

Aim: To measure the reaction time of a subject to 

auditory cues delivered at a predictable interval.

Procedure

Repeat Exercise 2 with a predictable interval of five 

seconds between each auditory cue.

Data Analysis

1 Use the same technique explained in Exercise 1 to measure 

and record the reaction times of the subject presented with 

predictable auditory cues.

2 Enter the mean reaction time for this exercise in Table HN-

1-2 on page HN-1-4.

Questions

1 To which auditory cue did your subject respond most 

quickly?

2 To which auditory cue did your subject respond to most 

slowly? For what reasons?

3 Did your subject respond more quickly or more slowly to 

same auditory cue as the other members of the class?

Table HN-1-2: Mean Reaction Times for Dif ferent Cues.

Cue
Mean React ion Time 

of  Your Subject  (ms)

Mean React ion Time 

of  Al l  Subjects (ms)

Shortest  Mean 

React ion Time in 

Class (ms)

Longest Mean 

React ion Time in  

Class (ms)

Visual

Auditory

Prompted Audi tory

Predictab le Auditory
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